CHAPTER

5

Performing Cisco Instant Connect User Tasks
All Cisco Instant Connect users are assigned a user role in the system. This role allows you to log into
the Administration Console, view and update your user information, update your communication
preferences so that you can use Cisco Instant Connect to communicate with other Cisco Instant Connect
users, and download the Dispatch Console client application to your PC.
The user role may be your only role, or you may have one or more additional roles, such as system
administrator, ops view administrator, dispatcher, or operator.
This chapter contains information about the Cisco Instant Connect user functionality and includes the
following sections:
•

Logging in to Cisco Instant Connect, page 5-1

•

Managing Your User Profile, page 5-2

•

Managing User Associations, page 5-12

•

Downloading the Dispatch Console, page 5-16

Logging in to Cisco Instant Connect
When you access Cisco Instant Connect via your browser, the first window that displays is the Cisco
Instant Connect Login window.
To log in to Cisco Instant Connect, enter your user name in the User Name field, enter your password in
the Password field, and then click Save. then click Log In.

Note

Be aware that user names are case-insensitive, and then click Save. that is, you can enter upper case or
lower case characters for your login user name. Cisco Instant Connect automatically converts any upper
case characters to lower case. However, passwords are case-sensitive, so make sure to enter them exactly
as they are configured. For more information about your Cisco Instant Connect login password, see the
“Managing Your User Profile” section on page 5-2.
After you log in, the Administration Console displays your user profile. If you have been assigned more
than one user role, the additional drawers that can be accessed according to those roles, display in the
left pane of the Administration Console. For more information about how an operator assigns user roles,
see the “Managing Users” section on page 3-1.
To access your user profile, navigate to My Profile from the Home drawer. See the “Managing Your User
Profile” section on page 5-2 for more information about the user profile.
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To view and edit user associations, in the Home drawer, click the My Associations link. See the
“Managing User Associations” section on page 5-12 for more information about managing user
associations.
To download the Dispatch Console client application to your PC, click the Download Dispatch Console
link from the Home drawer. See the “Downloading the Dispatch Console” section on page 5-16 for more
information about downloading the Dispatch Console client application.

Managing Your User Profile
Your user profile, also referred to as My Profile, includes your name, password, default location,
communications preferences, and other optional personal information. Your user profile was initially set
up by a Cisco Instant Connect operator, but you can change information, as needed.
Your user profile information is shown in the My Profile window, which displays after you log in to
Cisco Instant Connect. The user profile personal information is contained in the following information
tabs: General, Address, Dial Login, Dispatch Console, and Communications. Managing your user profile
involves reviewing and updating this information.
User and digit password requirements are configured by the system administrator or operator in the
Cisco Instant Connect server.
To manage your user profile, perform the following procedure:
Procedure
Step 1

If the My Profile window is not already displayed, navigate to the Home drawer in the Administration
Console and click My Profile.

Step 2

Review the information that is described in Table 5-1 and update this information, as needed, by
choosing the appropriate information tab.
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Fields that are designated as display only can be changed by a Cisco Instant Connect operator as
described in the “Managing Users” section on page 3-1 and the “Managing User Groups” section on
page 3-33.
Table 5-1

General Tab Fields

Field

Description

User image

This field displays an image that you have uploaded for the user. This image
appears for the user in the contact information in Cisco Instant Connect.
To upload a picture, click the Browse button and in the File Upload window,
navigate to and select the image file that you want. The file can be in GIF,
JPG, or PNG format.
By default, the image file can be up to 1 MB in size and is scaled to 200 x
200 pixels if the image is smaller than that. You can change these default
settings in the Image Configuration pane in the Administration > Options >
General window as described in Table 2-31 on page 2-86.

User Name

Display only. This field specifies the user name that was assigned when your
profile was created.
Note

First Name

User names are case-insensitive, and then click Save. that is, you
can enter either upper case or lower case characters for your user
name.

This field specifies your first name.
Valid characters: alphanumeric characters, space, hyphen (-), and
apostrophe (’)

Last Name

This field specifies your last name.
Valid characters: alphanumeric characters, space, hyphen (-), and
apostrophe (’)

Old Password

This field specifies the password that you enter when you log in to Cisco
Instant Connect.
For security, you should change your password periodically. You may be
forced to change your password based on the configuration in the server.
Note

New Password

Be aware that passwords are case-sensitive and must be entered
exactly as they were configured by the Cisco Instant Connect
operator.

This field specifies the new password that you enter when you change your
login password.
Valid characters: alphanumeric characters and these special characters: @ [
\ ] ^ _ ‘ ! “ # $ % & ' ( ) * , - . / : , and then click Save. { < | = } > ~ ?

Confirm Password

This field specifies confirmation of the entry in the new password field.

Description

Optional. You can enter a description in this field.
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Table 5-1

General Tab Fields (continued)

Field

Description

Password Expiration
Date

Display only. This field specifies the expiration date of your login password.
This field is read-only and is based on the password expiration settings that
the system administrator configures in the Cisco Instant Connect server.
Note

Cisco Instant Connect displays warning messages when your
password is about to expire, and after it has expired, and then click
Save. these messages display in the red error block in the My Profile
window. If you do not change your password before your old
password expires, you will only be able to log in to your user profile
to change your password. You will not have access to any other
windows in Cisco Instant Connect. If the Cisco Instant Connect
system administrator changes the password requirements, your old
passwords will not be affected until they expire. The new password
rules apply the next time that you create a new password.

Instant Connect Status

Display only. This field indicates whether the user is enabled or disabled.

Account Status

Display only. This field specifies the status of the user account.

Roles

Display only. This field specifies the Cisco Instant Connect roles that have
been assigned to you.
“All” indicates that you have been assigned the privileges of all roles.

Belongs To

Display only. This field appears if operational views (ops views) is enabled
and indicates the ops view to which you belong.
For more information, see Chapter 6, “Configuring and Managing Cisco
Instant Connect Operational Views.”

Step 3

Table 5-2 describes the fields in the Address tab.
Table 5-2

Address Tab Fields

Field

Description

Address

This field specifies your street address.
Valid characters: alphanumeric characters, spaces, and these special
characters: . , – ‘ # ( ) / :

Address (cont)

This field specifies additional street address information.
Valid characters: alphanumeric characters, spaces, and these special
characters: . , – ‘ # ( ) / :

City

This field specifies your city.
Valid characters: alphanumeric characters, space, hyphen (-), and
apostrophe (’)

State/Province

This field specifies your state or province.
Valid characters: alphanumeric characters, space, hyphen (-), and
apostrophe (’)
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Table 5-2

Address Tab Fields (continued)

Field

Description

Country

This field specifies your country.
Valid characters: alphanumeric characters, space, and period (.)

Zip/Postal Code

This field specifies your zip or postal code.
Valid characters: alphanumeric characters, space, and period (.)

Step 4

Table 5-3 describes the fields in the Client tab.
Table 5-3

Client Tab Fields

Field

Description

Default Location

By default, this field specifies the location that displays on your Dispatch
Console.
Choose a location from the drop-down list.
Note

To use IP phones with Cisco Instant Connect, you must assign a
location that is the same as the dial login default location. The server
assigns the configured default location to an IP phone user when the
user logs in to Cisco Instant Connect. (In this case, there is no user
selection for location.) IP phone users can access only the
associated channels that are assigned to their default location, along
with any assigned VTGs.

For more information about locations, see the “Managing Locations”
section on page 2-34.
Digit ID

This field specifies the identifier that you enter when you access Cisco
Instant Connect from a Cisco Unified IP Phone that has been configured for
use with Cisco Instant Connect.
Valid characters: numeric characters.

Old Digit Password

This field specifies the password that you enter when you initially access
Cisco Instant Connect from a Cisco Unified IP Phone that has been
configured for use with Cisco Instant Connect (the actual characters in the
password are represented by asterisks (*)).
By default, the password must contain at least 4 characters.
Valid characters: numeric characters

Digit Password (PIN)

This field specifies the password that you enter when you access the Cisco
Instant Connect service from a Cisco Unified IP Phone or personal
identification number (PIN) that you enter when you access the TUI. (The
actual characters in the password are represented by asterisks (*).)
By default, the password must contain at least 4 characters.
Valid characters: numeric characters

Confirm Digit Password

This field specifies confirmation of your entry in the Digit Password field.
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Step 5

Table 5-4 describes the fields in the Permission tab.
Table 5-4

Permission Tab Fields

Field

Description

Disable Audio

You cannot transmit or receive communications on the channel.

Listen Only

You are restricted to listening only on the channel, and then click Save. no
transmission is allowed.

Allow Latch

You can latch, or lock in, channels.

Advanced Dispatch
Console Permissions
(Multi-select, Tones,
DTMF, All Talk)

Specifies whether you are enabled for the following features on the Dispatch
Console:

Allow Complex Key
Setting

•

Channel multiselect for voice and tone transmissions

•

Alert tones transmissions

•

DTMF tones transmissions

•

All Talk channel transmissions

Allows you to configure keyboard hot keys (key assignments) for individual
PTT buttons and for the All Talk button.
Note

Allow Secure Channel
Patch

The Allow Complex Key Setting and Allow Secure Channel Patch
options will take effect only when they are globally allowed. For
more information, see “Managing Cisco Instant Connect Options”
section on page 2-85.

Allows you to patch a secure channel to any other secure or unsecure
channel, or to any incident or VTG. Disallowing this option prevents secure
channels from being patched.
Patching a secure channel into an incident is considered secure and is
allowed even if patching secure channels is disallowed.
Note

Default Talk Priority

Step 6

The Allow Complex Key Setting and Allow Secure Channel Patch
options will take effect only when they are globally allowed. For
more information, see “Managing Cisco Instant Connect Options”
section on page 2-85.

You default talk priority. The system uses this talk priority if you do not
choose another one. The system default talk priority is 4.

Table 5-5 describes the fields in the Communications tab.
Table 5-5

Communications Tab Fields

Field

Description

Notification Preferences This field specifies any combination of one or more E-mail, Short Message
Service (SMS), or pager address.
To manage your notification preferences, see the “Managing
Communications Preferences” section on page 5-7.
Radio Preferences

This field specifies the Instant Connect number for radios that support this
feature.
To manage your radio preferences, see the “Managing Communications
Preferences” section on page 5-7.
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Table 5-5

Communications Tab Fields (continued)

Field

Description

Cisco Spark Credentials

This field specifies the email ID that is registered with Cisco Spark for a
user. Required if the user will participate in Cisco Spark chats.
For related information, see the “Managing the Cisco Spark Server” section
on page 2-158.

Dialer Preference

These fields specify information that is required by Cisco Unified
Communications Manager and Cisco Unified Communications Manager
Express for the dialer feature.
To manage your dialer preferences, see the “Managing Communications
Preferences” section on page 5-7.

Dial Preferences

This field specifies one or more telephone numbers.
To manage your dial preferences, see the “Managing Communications
Preferences” section on page 5-7.

Step 7

Click Save to save any changes that you have made.

Managing Communications Preferences
Communications preferences specify how Cisco Instant Connect contacts you when a user-associated
policy executes.
These preferences are also used by Cisco Instant Connect when a dispatcher initiates a notification or
dial out to invite you to join an active VTG. For more information about notifications, see Chapter 8,
“Using the Policy Engine.”
When you specify communication preferences, you can provide the following information:

Note

•

Notification Preferences—Specifies how Cisco Instant Connect contacts you when a user-associated
policy executes. Also used by Cisco Instant Connect when a dispatcher initiates a notification or dial
out to invite you to join an active VTG. Can be any combination of one or more e-mail, Short
Message Service (SMS), or pager addresses.

•

Radio Preferences—Specifies one or more direct connect numbers for Nextel radios. This
information is used by the radio connect feature.

•

Dialer Preference—These fields specify information that is required by Cisco Unified
Communications Manager and Cisco Unified Communications Manager Express for the dialer
feature.

•

Dial Preferences—One or more telephone numbers at which Cisco Instant Connect contacts you
when a user-associated policy executes. Also used by Cisco Instant Connect when a dispatcher
initiates a dial out to invite you to join an active VTG.

A Cisco Instant Connect operator can configure user notification preferences. For more information, see
the “Managing Communications Preferences for a User” section on page 3-14.
This section includes the following topics:
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•

Viewing, Adding, Editing, or Deleting Notifications Preferences, page 5-8

•

Viewing, Adding, Editing, or Deleting Dial Preferences, page 5-11

•

Specifying the Order of Dial Preferences, page 5-12

Viewing, Adding, Editing, or Deleting Notifications Preferences
You can view, add, edit, or delete notification preferences in the user profile. To do so, perform the
following procedure:
Procedure
Step 1

Access the Home drawer in the Administration Console and click My Profile.

Step 2

Click the Communications tab.
The Notifications Preferences pane displays the following information:
•

Type—Method by which you get notified:
– Email—Cisco Instant Connect sends notification to an e-mail address that you specify.
– Pager—Cisco Instant Connect sends notification to a pager through an e-mail gateway.
– SMS—Cisco Instant Connect sends notification to an SMS through an e-mail gateway.

•
Step 3

Number/Address—This field specifies the e-mail address for the corresponding notification type.

Take the desired action:
•

To add a notification preference:
a. Click Add.
b. From the drop-down list, choose a method by which to receive notifications (Email, pager, SMS,

IDC, CIC, JABBER.
c. In the field next to the drop-down list, enter the e-mail address for the corresponding

notification method. For the SMS and pager methods, specify the e-mail address of the gateway
through which the message is sent to the device.
d. Click Done.
e. Repeat these steps as needed to add more notification preferences.
•

To edit a notification preference, follow these steps:
a. Check the check box next to the notification preference that you want to edit.
b. Click Edit.
c. From the drop-down list, choose a method by which you want to receive notifications.
d. In the field next to the drop-down list, enter the e-mail address for the corresponding

notification method. For the SMS and pager methods, specify the e-mail address of the gateway
through which the message is sent to the device.
e. Click Update.
•

To delete a notification preference, follow these steps:
a. Check the check box next to the notification preference or preferences that you want to delete.
b. Click Delete.
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Step 4

Click Save to save your changes.

Viewing, Adding, Editing, or Deleting Radio Preferences
You can view, add, edit, or delete radio preferences in the user profile. To do so, perform the following
procedure:
Procedure
Step 1

Access the Home drawer in the Administration Console and click My Profile.

Step 2

Click the Communications tab.
The Radio Preferences pane displays the following information:
– Type—Radio descriptor for a serial radio that supports the radio connect feature
– Value—Radio connect number of the associated radio

Step 3

Take the desired action:
•

To add a radio preference, follow these steps:
a. Click Add.
b. From the drop-down list, choose the type of radio for which you are configuring the radio

connect number.
c. In the field next to the drop-down list, enter the radio connect number for the radio.
d. Click Done.
e. Repeat these steps as needed to add more dial preferences.
•

To edit a radio preference, follow these steps:
a. Check the check box next to the radio preference that you want to edit.

You can use the up arrow and down arrow to move a check to an adjacent check box.
b. Click Edit.
c. From the drop-down list, choose the type of radio for which you are configuring the radio

connect number.
d. In the field next to the drop-down list, enter the radio connect number for the radio.
e. Click Update.
•

To delete a radio preference, follow these steps:
a. Check the check box next to the radio preference or preferences that you want to delete.

You can use the up arrow and down arrow buttons to move a check to an adjacent check box.
b. Click Delete.
Step 4

Click Save to save your changes.
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Specifying the Order of Radio Preferences
You can specify the order of the radios in your radio preferences. This feature is reserved for future use.
To specify the order of the dial preferences, perform the following procedure:
Procedure
Step 1

Access the Home drawer in the Administration Console and click My Profile.

Step 2

Click the Communications tab.

Step 3

Check the check box next to the dial preference type that you want to move to a different position in the
list.

Step 4

Click the up arrow button to move the dial preference up in the list, or click the down arrow button to
move it down in the list.

Step 5

Repeat Step 3 and Step 4 as needed to move other dial preferences.

Step 6

Click Save to save your changes.

Viewing or Updating Dialer Settings
You must configure the Dialer Settings items if you will use the dialer feature. In addition, you must
configure the CUCM or CME to which a client registers with the same information. (For more
information about the Dispatch Console dialer feature, see Dispatch Console User Guide for this
release.)
You can view, or update dialer setting in the user profile. To do so, perform the following procedure:
Procedure
Step 1

Access the Home drawer in the Administration Console and click My Profile.

Step 2

Click the Communications tab.
The Dialer Settings pane includes these fields:
– Dialer Phone Number—Unique number that a client requires to register with Cisco Unified

Communications Manager (CUCM) or Cisco Unified Communications Manager Express
(CME) when the user logs in. Displays on an end device when it places a call to a device that is
configured to display caller ID.
– End User Name—CUCM or CME end user name that is configured for the user.
– End User Password—CUCM or CME end user password that is configured for the user.
– Confirm End User Password—Confirmation of the password in the End User Password field
Step 3

Take these actions:
a.

In the Dialer Phone Number field, enter a unique number that the client requires to register with
CUCM or CME when the user logs in. Displays on an end device when the client places a call to a
device that is configured to display caller ID. This parameter must also be configured in CUCM or
CME.

b.

In the End User Name field, enter the CUCM or CME end user name that is configured for the user.
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Step 4

c.

In the End User Password field, enter the CUCM or CME end user password that is configured for
the user

d.

In the Confirm End User Password field, re-enter the password that you entered in the End User
Password field.

Click Save to save your changes.

Viewing, Adding, Editing, or Deleting Dial Preferences
You can view, add, edit, or delete dial preferences in the user profile. To do so, perform the following
procedure:
Procedure
Step 1

Access the Home drawer in the Administration Console and click My Profile.

Step 2

Click the Communications tab.
The Dial Preferences pane displays the following information:

Step 3

•

Type—This field specifies the description of the location to be dialed, such as business, car, or home.

•

Dial Number—This field specifies the telephone number of the corresponding location type.

Take the desired action:
•

To add a dial preference, follow these steps:
a. Click Add.
b. From the drop-down list, choose a description for the dial preference.
c. In the field next to the drop-down list, enter the telephone number for the corresponding dial

preference.
This field can contain numerals, dashes (-), and spaces. If the telephone number includes an
extension, precede the extension with an uppercase or lowercase X.
d. Click Done.
e. Repeat these steps as needed to add more dial preferences.
•

To edit a dial preference, follow these steps:
a. Check the check box next to the dial preference that you want to edit.

You can use the up arrow and down arrow to move a check to an adjacent check box.
b. Click Edit.
c. From the drop-down list, choose a description for the dial preference.
d. In the field next to the drop-down list, enter the telephone number for the corresponding dial

preference.
This field can contain numerals, dashes (-), and spaces. If the telephone number includes an
extension, precede the extension with an uppercase or lowercase X.
e. Click Update.
•

To delete a dial preference, follow these steps:
a. Check the check box next to the dial preference or preferences that you want to delete.
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You can use the up arrow and down arrow buttons to move a check to an adjacent check box.
b. Click Delete.
Step 4

Check the Dial after sending notifications check box if you want the policy engine to attempt to call
you by using the numbers that are configured in the Dial Preferences list when an associated policy
executes.

Note

Step 5

If the Dial after sending notifications check box is checked, Cisco Instant Connect first sends all
e-mail notifications, then attempts to place a call to the participants by using the dial preferences
that are set in the user profile.

Click Save to save your changes.

Specifying the Order of Dial Preferences
You can specify the order of the numbers that you add to your dial preferences. Cisco Instant Connect
dials the numbers in the order that you specify, beginning with the first number in the list, until every
number has been tried, or until one of the calls in answered. If the call is successful, Cisco Instant
Connect connects the call and stops. If the call is unsuccessful, Cisco Instant Connect continues to place
calls to the numbers, in the order that they appear in the preferences list, until a call is successful or until
all of the numbers in the list have been tried (whichever comes first).
To specify the order of the dial preferences, perform the following procedure:
Procedure
Step 1

Access the Home drawer in the Administration Console and click My Profile.

Step 2

Click the Communications tab.

Step 3

Check the check box next to the dial preference type that you want to move to a different position in the
list.

Step 4

Click the up arrow button to move the dial preference up in the list, or click the down arrow button to
move it down in the list.

Step 5

Repeat Step 3 and Step 4 as needed to move other dial preferences.

Step 6

Click Save to save your changes.

Managing User Associations
In Cisco Instant Connect, you can be associated with channels, radios, incidents, phones, VTGs,
policies, and keys. You can view Cisco Instant Connect resources to which you have been associated in
the My Associations window in the Administration Console.
The My Associations window contains information tabs that display the items to which you are
associated in Cisco Instant Connect. See Table 5-6 through Table 5-11 for information about the
resources within each of these tabs.
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Table 5-6

Channels Tab Fields

Field

Description

Associated Channels

This tab specifies the channels to which you are associated.
When you are associated with PTT channels, those channels appear as
options on a Dispatch Console or a properly-configured
Cisco Unified IP Phone.
To view the channels to which you are associated, choose Channels from
the View drop-down list.
The following information displays about the channels to which you are
associated:
•

Channel Name—This field specifies the name of the channel.

•

Status—This field indicates whether the channel is enabled or disabled.

•

Latchable—This field indicates whether the channel can be latched
(locked).

•

Disable Audio—This field indicates whether audio is disabled.

•

Listen Only—This field indicates whether the Listen Only attribute is
enabled.

Table 5-7 describes the fields in the Radios tab.
Table 5-7

Radios Tab Fields

Field

Description

Associated Radios

This tab specifies the radios to which you are associated.
The following information displays about the radios to which you are
associated:
•

Radio Name—This field specifies the name of the radio.

•

Location—This field specifies the location of the radio. The location
determines whether the radio is reachable.

•

Multicast Address—This field specifies the multicast address of the
radio.

•

Type—This field specifies the type of radio.

•

Status—This field specifies the status of the radio.

Radios can have one of the following statuses:
•

Enabled—This status specifies that the radio is enabled

•

Disabled—This status specifies that the radio is disabled

•

Descriptor Corrupted/Missing—This status specifies that the radio/tone
descriptor file is either corrupted or is missing from Cisco Instant
Connect

•

Active—This status specifies that the radio is in an active state

•

Pending—This status specifies that the radio is not currently in an
active state
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Table 5-8 describes the fields in the Incidents tab.
Table 5-8

Incidents Tab Fields

Field

Description

Associated Incidents

This tab specifies information about your incidents:
•

ID—This field specifies the incident identifier.

•

Name—This field specifies the incident name.

•

Started—This field indicates when the incident started.

•

State—This field indicates whether the incident is active or inactive.

Table 5-9 describes the fields in the Phones tab.
Table 5-9

Phones Tab Fields

Field

Description

Associated Phones

This tab specifies the phones with which you are associated.
When you are associated with phones, you can use your Dispatch Console
to communicate with other users who are connected via a telephone.
The following information displays about the phones to which you are
associated:
•

Dial Destination—This field specifies the phone number to call (the
number of the associated phone).

•

Label—This field specifies the label that displays on the Dispatch
Console.

Table 5-10 describes the fields in the Virtual Talk Groups tab.
Table 5-10

Virtual Talk Groups Tab Fields

Field

Description

Virtual Talk Groups

This tab specifies the VTGs to which you are associated.
When you are associated with VTGs, you can communicate with other
participants of that VTG.
To view the VTGs to which you are associated, choose Virtual Talk
Groups from the View drop-down list.
The following information displays about the VTGs to which you are
associated:
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Table 5-11 describes the fields in the Policies tab.
Table 5-11

Policies Tab Fields

Field

Description

Associated Policies

This tab specifies the policies to which you are associated that you can
activate by calling the policy engine.
The window displays the policy name in the Policy Name column.
You can change the order in which the policies display by checking
the check box next to a policy name and clicking the up and down
arrows at the bottom of the policy list.

Note

Table 5-12 describes the fields in the Keys tab.
Table 5-12

Keys Tab Fields

Field

Description

Associated Keys

This tab specifies the keys to which you are associated. For more
information about keys, see the “Managing P25 Keys” section on page 2-53.
The following information displays about the keys to which you are
associated:
•

Name—This field specifies the name of the VTG.

•

Algorithm—This field indicates the algorithm that the key uses for
encryption and decryption (DES or AES).

•

SLN (Hex)—This field represents the storage location number of the
key in decimal format and in hexadecimal format. The hexadecimal
format SLN is shown in parentheses.

•

Key Type—This field indicates that the key type is TEK (traffic
encryption key).

To view the resources with which you are assigned, see the “Viewing User Associations” section on
page 5-15.

Viewing User Associations
To view your user associations, perform the steps in the following procedure:
Procedure
Step 1

Access the Home drawer in the Administration Console and click My Associations.

Step 2

To view your user associations, click any of the following information tabs:
•

Channels—This tab displays the channels to which you are associated.

•

Radios—This tab displays the radios to which you are associated.

•

Incidents—This tab displays the incidents to which you are associated.
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•

Phones—This tab displays the phones to which you are associated.

•

Virtual Talk Groups—This tab displays the VTGs to which you are associated.

•

Policies—This tab displays the policies to which you are associated.

•

Policies—This tab displays the keys to which you are associated.

Note

You can change the order in which the policies display by checking the check box next to a
policy name and clicking the up and down arrows.

See the “Managing User Associations” section on page 5-12 for a description of each of the association
tabs.

Downloading the Dispatch Console
As a Cisco Instant Connect user, you can download the current version of the Dispatch Console to your
PC. To do so, perform the following steps from the PC to which you want to download the Dispatch
Console.
For more information about the Dispatch Console, see Dispatch Console User Guide for this release.
Procedure
Step 1

Access the Home drawer in the Administration Console and click Download Dispatch Console.
Cisco Instant Connect initiates the Dispatch Console download utility, which installs the Dispatch
Console on your PC and creates a shortcut on your desktop.

Step 2

Follow the on-screen prompts to download and install the Dispatch Console.
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